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and write the answer in the space provided against each question.
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pages or questions etc. If so, get it replaced with another question paper, before question paper
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One (1) mark will be awarded for each correct answer. There will be negative marking and (- %)
mark will be awarded for each incorrect answer.

The unanswered questions will not attract negative marking

Return the Question Paper cum Answer Sheet to the invigilator after the examination is over.
Mobile, Electronic Watch and other Electronic Gadgets are prohibited in the examination.
There should not be any cutting or overwriting in the Answer.
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1,

Two identical spheres, A and B, each with a charge Q, are separated by
a distance r (much larger than their diameters). A third identical,
uncharged and conducting sphere C is first brought into contact with
sphere A, then brought into contact with sphere B, and finally
removed. What is the new force of repulsion between spheres A and B?

2 T e, A 3R B, Ul T 399 Q & T, Uh gl r (376 AW
Ed 92T) BT 3T fobT 1 € T AT GA M, ToAT SafSia ofR Hare
&5 C &1 TeeT 85 A 3 Tuas B 1T ST 2, T & B o Ttk H 1T STel
2. 3y 3iq B ger AT AT 21 A 3R B &5l o WfTer HiqeeioT &7 4T St <Ft

82
A.
QB
F = 5
4megre
; 307
B. . __
32megr-
C. 0
F=—
l6megy
D. 3¢g?
Fem
16megrs
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Given below are two statements
Statement I: Electric potential is constant within and at the surface of

each conductor.
Statement II: Electric potential just outside a charged conductor is

perpendicular to the surface of the conductor at every point.

In the light of the above statements, choose the most appropriate
answer from the options given below

A. Only Statement I is correct

B. Only Statement II is correct

C. Both the statements I and II are correct

D. Both the statements I and II are incorrect

19 3t e Ry e &

BT 1: U Teieh bl Hdg b Wit 3R Tde W faga emar fer adt 2|

BT 11: TP AT =Tetes &b 3o et g fova & folg X =rreres B
HdE & Agad BT 8|

ST BT Bl e H W@ 5, A T 7Y feeul § & god Sugerd I
I

A. I BT e &

B. 5 BT I TETE

C. T P2 1 3R 11 9e1 &

D. EH1 B [ 3R 11 T £ |

o o0 @ »

A current of 1.5 A is flowing through a triangle, of side 9 ¢cm each. The
magnetic field at the centroid of the triangle is: (Assume that the
current is flowing in the clockwise direction.)

A. 3 x 107 T, outside the plane of triangle

B. 23 x 10-7 T, outside the plane of triangle
C. 23 x 10-5 T, inside the plane of triangle
D. 3 x 103 T, inside the plane of triangle

1.5A T T ¥RT Teb BT & ATz & 78 T2 2, Torerehl vrcdiep vyotr 9 &7t 21
PRIST & bk W YeehId &5 §: (T ST o oy =gt <61 feom & e
)

.3 x 107 T, 3T % a1 o aTel

. 2V3 x 107 T, BT & e o 97X

243 x 10-5 T, BT o aT & 3feT

. 3% 105 T, BT & deT o 3iex
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What is the force exerted on a stationary charge when it is placed in a

magnetic field?

A. Zero

B. Maximum

C. Minimum

D. Depends on the strength of the magnetic field

e TR ST G fheT ot AT SITaT & STl S8 Yelehla & H @ STl
87 .

A I
B. 3Tfeddq

C. g
D. aebr &5 Y e W it e 8

If wattless current flows in the AC circuit, then the circuit is:
A. Purely Inductive circuit

B. Purely resistive circuit

C. LCR series circuit

D. RC series circuit only

7f% it afiger # areerd URT vaTed 2l €, ar uiue &
A. fo9r &u § U aftmy

B. s o9 & ufeit uftoy

C. T, T, 3TR. el uiger

D. 3R, 9. J@e uiige el

A concave mirror for face viewing has focal length of 0.4 m. The
distance at which you hold the mirror from your face in order to see
your image upright with a magnification of 5 is:

et 2 % AT U sraad U Bl BIhd waTs 4 Wi widl g1 e gl
TR 3T SO BTA @l 5 3 ST 3 e dir <@ & Ay oo <El § U

%1 UEd & T8 €
A.0.16 m
B. 1.60 m
C. 032 m
D. 0.24m
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7.

When radiation of wavelength X is incident on a metallic surface, the
stopping potential is 4.8 V. If the same surface is illuminated with
radiation of double the wavelength, then the stopping potential
becomes 1.6 V. Then the threshold wavelength for the surface is:

el Tt T T T W AT e ), B fafestor arafad 2iar €, d v

&TdT 4.8V Bl 81 AR IHT Hag &1 a1 o % I fAfmor & weprferd
TeRaIT AT €, o e Bl &THAT 1.6V &1 ST €1 9 Tdg & folg AT air

et &
A 2\
B. 4\
C.6A
D. 8A

Zener breakdown occurs in a p-n junction having p and n both:
A. lightly doped and have wide depletion layer.

B. heavily doped and have narrow depletion layer.

C. heavily doped and have wide depletion layer.

D. lightly doped and have narrow depletion layer.

| SR SIS U -0 e § BT & foad oY st et St B 8
A. BBl S1T febaIT ST & 3TR SEH AU STG&T W Biel €.

B. WRI SI7 febgT ST1dT 8 3R SEH Teh1ot 3Taerd IR Bl &,

C. YT 19 BT STTAT © 3R 36 1Y STaerd IR Bl &,

D. BT 31T feharT ST & AN gdH Heblvf saery Wa gl 2|

For a transistor to act as a switch, it must be operated in:
A. Active region

B. Saturation state only

C. Cut-off state only

D. Saturation and cut-off state

ifSre 35 o e 8 o 7 @ ot 35 v, <8 P geneie foea T |
SHEEH

A. Tforg &

B. Hftd dheret

C. BZ-31% T BT

D. Hlt 3R -3 TT

i
i
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10

A particle executes S.H.M, the graph of velocity as a function of
displacement is

A. A helix
B. An ellipse
C. A parabola
D. A circle

U ST T, T, TH. Bl (TSTied aT &, oo & Betd & B9 § a7 Bl
% &

A. TP gfeied

B. T {EHqT

C. TP WIAT

D. Tk

11

' The concept of a stored-program computer was first proposed by:

A. John von Neumann
B. Alan Turing

C. Charles Babbage
D. Ada Lovelace

1S off:

A. ST G HA
B. Terd ST
C. TTcH dee

iD.aanaaé*er
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12

Computers used primarily for controlling industrial processes,
manufacturing equipment, and machinery are called:

A. Supercomputers
B. Mainframes
C. Minicomputers

D. Workstations

e BY Y AT ufckarst, fafaior suesor ofk 7efiTd @1 Frifia s0
& ToTQ IuRNT fobg T aTet SRl Bl et ATaT €

A. GIEER

B. HTHH

C. Tt R

D. T

Which among the following is the Application software?
A. Linux

B. Unix

C. Microsoft Power Point

D. Macros

Fferfed o & #1971 Tllhe T Hided 82
A. TeiTerg

B. g

C. HTShIGTTR YR Wee

D. HEBIST
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Which monitor would provide the highest level of performance?

A. VGA
B. XGA
C.CGA
D. SVGA

B T {1t ISTH TR BT TE9H UM Hm?
A. FRiT

B. TR

C. Hisig

D. THdIT

12

The software that controls and monitors functioning of a specific
device on computer is called as , it operates or controls a
particular type of device that is attached to a computer.

A. Device Drivers
B. Assembler
C. Language Processor

D. Interpreter

FFeaITR ST el TR ek TAfITs SUeRoT & HHeb Bl FHafd #fiR JiHes

71 3@ ST & S SR A ST RIelT |
A. Tearsd gism

B. 3dd

C. wiTaNT TIHET

D. $X
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16

Which of the following is the design in which both the hardware and
software are considered during the design?

A. Platform based design
B. Memory based design
C. Software/hardware codesign

D. Peripheral design

e § @ o 91 feemeT € fad fSome & SiH 2reaer 3R 91RO
2T 9 faam fosam Srar 27

A. TeHH TR fEstreT
B. T e fastme

C. HIFZIIY/ETERR BISHTST
D. Uity fesreT

17

All are computer operating systems except:

A. Microsoft office

B. Linux

C. Windows 10

D.iOS

eI Bl Bligwt Tt e TIRfT fien &
A. HTShIHTHR JThHE

B. feierd

C. fae= 10

D. 3TE. 311, T4,

18

How can we set vertical alignment?

A. Page Setup command from File menu

B. Page Setup command from Format menu
C. Paragraph command from Format menu

D. Font command from Format menu

B SHE L Hg0T B8 e R wed 22
A. BT3d G § IS G2 FHIE

B. WY 4 9 U Y237 FHHE

C. UTSU el T 35 FHHS

D. WM 7 § i< IS
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20

PowerPoint was officially launched on May 22, 1990 the same day
that, Microsoft released which of the following windows?

A. Window 4.0
B. Windows 3.0
C. Window 1.0
D. Window 2.0

RS T TR a0 22 W, 1990 &1 IHT &7 wier febarm a7 o,
o o wresmTRe ¥ Fefefad & § g fast o <l foear en?

A. fagr4.0
B. fdgT3.0
c. fErio
D. fde12.0

Which key is used to indent a paragraph in MS-Word?

TTg-ad # T TR Bl §3¢ F F e o s 1 SuT fehat STrar
27

A. Alt

B. Tab

C. Ctrl

D. Esc

21

The keystrokes Ctrl + I is used to:

A. Increase font size

B. Inserts a line break

C. Applies italic format to selected text

D. Indicate the text should be bold

BILIF Ctrl + 1 b1 IFAT 71 3 ToTg Fom AT &
A. B T 3THR 18

B. e Gferet farme wfefcrd i &

C. T OTS W g e URd AN BT &

D. £t & o UTe siies gAT 91fey
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22

In a Client-Server network architecture, what role does the server play?

A. Provides data security

B. Executes programs for clients

C. Receives services from clients

D. Manages network traffic

FATS-He A2aeh TR , TR T fefept Furelm €7
A. ST GIETT USH AT €

B. UTeeh! & foiq wrRisH fremfed wedr &

C. UTeeh! T HATE YTt AT &

D. ~2ad ATATATA BT YL BT &

23

What types of communication media are used in a wired network?

A. Copper wire, twisted pair, or fibre optic cables
B. Radio frequency waves
C. Infrared waves

D. Antennas and sensors

a1 Jeqeds H obH TR o TER ATH T ST febam ST7ar 22
A. 16T dR, 93 SiS] T HIEeR 3Tt el

B. feat g aim

C. 3TeRerd Tl

D. TEHT 3R Had5H

24

What is passed along the ring in a ring topology?
A. Data packets

B. Electrical signals

C. Radio waves

D. Nodes

T Zrarerett ® T < qrer o i feba st 22
A. Tk

B. Taed G

C. e

D. 719
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25

How are devices connected in a star topology?
A. Linear connection to form a ring

B. Direct connection without any central device
C. Through a central controller

D. Meshed together forming a network grid

T TR & SUhT0T 8 9 BId 87
A. o1 9T & foe U dey

B. AT Tt 21T U 3 T PAFH
C. $ Fraas S araq 4

D. T Jeads firg a1 §¢ U a1 ey

26

What is the primary function of the Internet Protocol (IP)?
A. To establish secure connections for online

shopping.

B. To regulate social media usage.

C. To route data packets across networks.

D. To design web page layouts.

SeEe HIRIHT (3TE. ) BT Wrerfees Href o &7

A. 3iTaTeT wier 3 oy grferd dudh wnfod BT
B. Tl Hifgar & Suan &l fafrafdd &

C. F2gds § 22T G Bl B BT

D. e O aTee fetreT o & fofg|

27

What is the purpose of an Internet Service Provider (ISP)?

A. To develop web applications.
B. To provide access to the Internet.
C. To regulate online content.

D. To manufacture computer hardware.

ST BT VRTAT (3MTE. TH. ) B ILT T 87
A. 99 U feeBiad FET|

B. £ % Ugd WM B @ [l

C. 3TATST AT B fe e |

D. PR TETI BT FHIOT HEATI
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28

Which technology allows users to access files stored on remote servers
over the Internet?

A. VPN (Virtual Private Network)
B. IFTP (File Transfer Protocol)
C. DNS (Domain Name System)

D. VoIP (Voice over Internet Protocol)

I T bl STATTRAI Pl ST T R HR R UL BIgad! deb
Uge B Al &t 82

A. 91 Ot T, (T TS Aeads)

B. U%. &, Ul (HId ZHW HIZIbia)

C. 2. T, Tq. (3 W faem)

D. dt. 31, 37E. 0T, (TTa MR ST WSIhie)

X (RS

29

What is the primary function of a podcasting platform?
A. Sharing photos and videos

B. Broadcasting live events

C. Streaming music playlists

D. Distributing audio content in episodes

USRI THEHIH o1 Ul fHeh il &7 22
A. BI2I AR FIfEAT IR R §Y

B. W1 PBRIHHT BT THROT

C. EIHT §id wifere

D. TftETE | STfear qrut faafia s
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30 | The substances whose compositions are not uniform and different

components are mixed are called
A. Homogenous substances

B. Heterogeneous substances

C. Pure substances

D. Elements

157 UerelT & EET U T Tel et & SR ffi=T e fAfSd Bld €, 3%

e AT &
A. TAEY Teref
B. fawH ueref
C. ge uard

D.dd

31

Who proposed Law of Conservation of Mass?

A. Antoine Lavoisier

B. Joseph Proust

C. Lorenzo Romano

D. Joseph Louis

S HR&TOT BT T U1 o Tm?
A. TS AETE R

B. SIH® TRE

C. @RS A9

D. SH% Jsd
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32

Which of the following is not true regarding balanced chemical
equations?

A. They contain the same number of atoms on each side.

B. Electrons are also balanced.

C. An equal number of molecules on both the side.

D. Follows the law of conservation of mass.

Hfeid Tt FHIET & Hey B Fmfafad & 4 £ 91 g8 18 82
A. TH T a% HH H&AT § A7) € B

B. oiag Ht dgfrd g &
C. 3T X STt BT T WA |

D;awm%wmaaﬁmwww%

33

Who discovered the electron?
A. Rutherford

B. Chadwick

C. Thomson

D. Goldstein

gorleRZ BT @ISt fosg hr?
A. TIHIS
B. Tefd®

C. omgq

D. Mes A
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Which radioactive element is used in the treatment of cancer?

A. lodine-131

B. Uranium-234

C. Plutonium-239

D. Cobalt-60

3 3 T B fobr YT ey o7 ST fehT ST €2

A. STTEM-131
B. JHaH-234

C. Wl aA-239
D. BlEE-60

35

Find the Molecule with the Maximum Dipole Moment.
SATEreBe™ TEXga HarT aTaT 379 31T S|

A. CH4

B. NH3

C. CO2

D. NF3

36

If liquids A and B form an ideal solution then:
A. The entropy of mixing is zero
B. The free energy of mixing is zero

C. The free energy as well as the entropy of mixing are zero

D. The enthalpy of mixing is zero

A et verel @ 7R o gep el et ST €
A. fasror &1 gt S 21

| B. TA=roT &1 e St A B

C. e Fofl o Frer-are o 1 T g
D. fersyor 1 Tt 3 Bl 2|
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37

Which of the following property cannot be used to describe the state of
a system?

A. Pressure
B. Volume
C. Temperature

D. Universal gas constant

Fmfcfea & & foe 1ot &1 Sui fepet voTTedt 1 feifa &1 avft et &
foTe 72T fopaT 511 gepar 22

A. 3dTd
B. 3T™Idq

C. d9A

D. Ardifaes 19 feRie

38

An open system allows the transfer of

A. Only mass
B. Only energy
C. Both mass and energy

D. Neither mass nor energy

T Gl UOTGll o TT{cROT bl 1Al et &1
A. hae SHAH

B. el SHull

C. SHHM 3R Haf AT

D. T Al 5w 311k 7 &€ ot
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39

Which of the following is not an application of Hess’s law?
A. Determination of heat of formation

B. Determination of heat of transition

C. Determination of gibb’s energy

D. Determination of heat of hydration
Freifeifaa & & 17 1 89 b FaH o1 ST Ael 87
A. TS BT ST Bl T

B. THHOT &I HHT T erfror

C. Tiresr 1 et a1 ferfzor

D. SISt I FHHT Bl fefor

40

The melting of ice into liquid water is an example of
tube reaction.

IA Endergonic

B. Exergonic

| C. Exothermic

D. Endothermic

FATN S ab BT g S WfAfsET ol T e Bl
A. TETi®

| B. TS

C. TaTfhE

D. GEufiE

41

Let S = {x : x is a positive multiple of 3 less than 100}. P=
{ x : x is a prime less than 20} . Then n(S) + n(P) is:

AR AR S = (x: x, 100 ¥ HH 3 HT ETHE [0 &
P = {x: x 20 & BH B AT 2| T n (S) +n (P) &:

A. 34
B. 41
C. 33
D. 30

(b) 41
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42 If (a,b) , (c.d) and (e,f) are the vertices of A ABC, and A denotes the
area of AABC, then ja ¢ e|2isequalto:
b d f (a) 4A2
1 1 1
IfE (a.b), (c,d) 3R (e,)) AABC F IS &, 3(WA, AABC & &5 &I ZorfT
%,T-ﬁ a ¢ e2783Hb W T
b d f
1 1 1
A. 4A?
B. 2A?
C. 2A
D. 4A
43 dy:: *a d’y
orertiol counpon |1 ()] - 22 5. | ()2
Degree of the differential equation : |~ ‘dx: ax” is: (D)
5 3‘-- -
1+ (ﬂ)-] T_dy
\dx dx*  3rqehel GHIGUT Bl 21T 30 UK ¢
Al
B.2
C. not defined
D. 0
44 | Tfcos x +sec x =2, then cosx + sec3x is equal to
?Jﬁ'cosx+secx:2?,?ﬁ0055x+sec5x§'H€FW?a>r: (a)2
A2
B. 52
G 1
D. 25
45 | Unit vector along % . where coordinates of P and Q respectively are
(2,1,-1) and (4.,4,-7) is : @+

PO % T HTE A, ST P 3R Q & Fenies B (2,1,-1) 3R
(4,4,-7) Ear: _

A. 2i+3}- 6}
B. -2; -3+ 6}
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46 | The number of different four digit numbers that can be formed with the
digits 2,3,4,7 and using each digit only once is : (c) 24
ST TR 3iehT 8T TReATait bl T il 7% 2,3,4,7 o |1 ST T
Hebell & 3R WeIeh 3ieh o bl Uoh SR IUANT BT ST HebalT &:
A. 120
B. 96
C.24
D. 100
47 If the sum of numbers obtained on throwing a pair of dice is 9 , then
the probability that number obtained on one of the dice is 4, is :
(d):
7% e STTET uTET Seh TR W1 TEATSAT &1 A1 9 8, ol Teb UTHT TR 9T 2
T 4 € BT &
A1
B. 3
C.1
D. 1
48 ] f gtos” *eini(2n + Lx dx
For any integer n , the value of - is: (©0
I pros sin’{2n + Lx dx
fomdt oY quTleh n o fei, - 1AM &:
A. -1
B. 1 |
C.0 | |
D2
49 | The area of the circle centred at C(1,2) and passing through P(4,6) is : (a) 25w
C(1,2) T BT 3R P(4,6) T ToRA AT el T &FIhe &
A. 25x
B. 10n
C.5n
D. none of these
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50

If the direction cosines of a line are < - ,1-~:,1*: >, then:
IR feet @ T feemsiareT < 2 e > 2,

A 0<c<]
B.¢c>2

C.c=+\2
D.c=+V3

(d) c=+V3
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